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NOTE TO NPMs 

Each National Centre will have slightly different processes for monitoring and managing the workflow of staff 
involved in the translation/adaptation process. Sometimes staff will be familiar with the National Centre, the PISA 

Portal and specific National Centre processes. Other staff will not have this exposure or knowledge. In order to 
accommodate for these differences, this Guide includes text in <angle brackets> that may need to be adapted. 

Remove this box and update the Table of Contents (page numbers) after reviewing and 
adapting all texts between < > 

 

INTRODUCTION 

1. Thank you for agreeing to translate test materials for the PISA2015FT survey. To carry out 
this assignment, you will translate the materials using the Open Language Tool (OLT) XLIFF Translation 
Editor and you will download/upload XLIFF files to preview source and translated units on an online 
facility, the PISA2015 portal.  

2. The present Translator’s Guide provides detailed instructions relevant to your role as 
translator. It includes a section on Initial Preparations, a step-by-step detailed and illustrated Workflow 
(full version), a Quick-Reference Guide (short version of the Workflow, which you can use once you are 
familiar with the process), and an Appendix with additional hints on using the OLT software.   

3. The translation of PISA test units involves double independent translation followed by 
‘reconciliation’ of the two initial translations, verification, national review and final check – according to 
specifications described in the PISA2015FT Translation and Adaptation Guidelines. To successfully carry 
out your translation assignment, you need to be familiar with this document, <provided by the National 
Centre>. 

4. In addition, the PISA2015 CBA Translation Workflow document, <provided by the 
National Centre> provides detailed description of the computer assisted workflows for translation and 
verification of the PISA instruments. This can be a useful additional reference for carrying out your 
assignment. 

5. There are two source versions of the PISA2015FT test units, English and French. <You will 
be advised by the National Centre whether you are assigned to translate from English or French.>   
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INITIAL PREPARATIONS 

6. Before starting your work, you need to: 

o Read the PISA2015FT Translation and Adaptation Guidelines a first time thoroughly, and 
keep this document at hand for consultation. 

o Check that your PC complies with the following minimum requirements: 

- Operating system: Windows XP, Vista, 7 or 8 (the OLT software will not run on Macintosh 
or Linux OS)  

- Microsoft Office Suite (or just MS Excel): 2007 or later. 

- Browser: Firefox (v10.0 or later) is recommended. Other supported browsers: Chrome 
(v18.0 or later), Safari (v5.0 or later), Internet Explorer (v8.0 or later); however, only Firefox 
may be used to preview CBA units. It is best to use Firefox for all PISA work. 

o Download and install the OLT software from the PISA Portal. It can be found in the 
Materials -> 2015 Field Test Resources -> Translation -> OLT folder. The installation 
instructions are included in the download folder. 

o <Receive from the National Centre> your credentials for logging in to the PISA2015 
Portal, a list of the units you are assigned to translate, and instructions for downloading the 
corresponding ‘TAS’ (Test adaptation Spreadsheet) Excel file(s) – See the PISA2015FT 
Translation and Adaptation Guidelines for a description of the latter. 

 

WORKFLOW PER TRANSLATION SESSION – FULL VERSION 

Login to the PISA2015 Portal, download files and launch preview 

7. Go to the PISA portal – URL: http://pisaportal.tudor.lu/portal – and login by entering your 
Username and Password <provided by the National Centre>. 

8. Navigate to the Monitoring workspace: 

 
9.  In this workspace is the Translation Monitoring Report. It shows all active translation 
activities for your country and language assigned to you or somebody with your role. Use the filters on 
the left of the screen to further refine the list of tasks you can choose to work on. See the PISA Portal 
User’s Guide for a detailed description of the Monitoring Report. 

10. Select a unit (or a batch of units) that you will translate by clicking the button in the “exec.” 
(Execute) column. A small popup window will be displayed, which includes a link to the XLIFF file(s) in 
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the document repository that you will need. Save the XLIFF file(s) to an appropriate location on your 
computer. It is recommended to save the XLIFF files in two different subfolders labelled e.g. “Originals” 
and “Translated”, in case it is later necessary to revert to an original (OLT does not allow to save a file 
under a different name). 

11. In the Translation tab of the portal is a widget where you can upload and preview a unit. 
When the XLIFF is uploaded, a preview screen will open in a new browser tab. This preview will show 
the entire unit, including all questions. Preview the XLIFF you will be working on before making any 
changes. It is recommended that you try to solve the task as if you were a student taking the test: this will 
help you think about the best translation solutions. 

12. Keep the preview screens open for consultation when you actually translate. (If possible, use 
a work station with two monitors, so that you can reserve one of them for previews.) If you prefer to 
translate offline, you can now interrupt your Internet connection. 

Translate using OLT 

13. Launch OLT (from the Windows Start/All Programs menu, or from the desktop shortcut). 
Enter your initials as Translator ID. You will need to enter this ID only once and you do not need to 
remember it. 

 
14. From the Options menu, check that Update Tags and Autopropagate are not selected 
(unchecked). All other options should be checked. You will only need to do this once. 
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15. From the File menu, select New Project and create a project called e.g. PISA2015FT. Select 
Source Language: English (United States) OR French (France); Target Language: your language. Note: 
OLT will automatically open the previously used project when you launch the program, and the same 
project should be used for all the PISA2015FT files, so you need to create a project only once for this 
translation assignment. 

 

16. Open the XLIFF file: click on the Open File button  and navigate to the file you saved 
on your computer in step 10. Select it and then click on Open (or double-click on it). 

17. If a window opens like the one below, asking you if you want to automatically translate 
segments in the file, select NO (this is a dangerous operation). 
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18. When the file is opened, the screen is divided in three sections: source pane, target pane and 
match pane. You can adjust the horizontal line above the match window by dragging it, if you want the 
source and target panes to have more space than in the default view. 

 
 

19. OLT displays the translatable elements separated in segments. Translate the segments one by 
one, by overwriting the text in the target pane (right side) and then moving to the next segment by 
clicking on the Confirm and Translate Next button    in the toolbar (keyboard shortcut: ALT-Enter). 
This action enters your translation in the Mini-TM (see later). Save the file OFTEN as you work in case 
of crashes (keyboard shortcut: CTRL-S). 

20. Although the XLIFFs for PISA2015FT are typically organized with segments for the items 
(questions) coming first, followed by those for the ‘stimulus’ text (the text to which the items refer), it is 
strongly recommended to translate first the stimulus text and then the items – following the order 
presented in the TAS.   

21. During your translation task, consult the item-specific translation and adaptation 
guidelines in column D of the TAS. You can also use column E (Country Comments) of the TAS to write 
any comments you may have for the attention of the Reconciler who will be reviewing and using your 
translation, for example to explain a choice you have made, explain a difficulty or doubt, propose an 
alternative translation you can think of, report a layout or functionality issue, etc.  

Target 
pane 

Source 
pane 

Match 
pane 
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22. As your Mini-TM builds up, you will be able to reuse translations for segments that reappear 
later in the file (or in other files) with identical or very similar source text. When this happens (when the 
software detects a match) one or more previous translation(s) will display in the match pane and the 
Transfer button  is enabled. If appropriate, you may then select one of the matches and click 
on the button, to transfer the translated text to the target segment you are on without needing to type it. 

• If edits are needed, make them and then click on the button Update Mini-TM   in the 
toolbar (keyboard shortcut: CTRL-U). A window will display asking you if you want to 
Overwrite the entry already in the TM or Add another entry. Choose Overwrite if you want to 
keep only the latest (edited) translation, choose Add if you think the previous (unedited) 
translation could also come in handy. 

• Move on to the next segment by clicking on the Next Segment button   in the toolbar 
(keyboard shortcut CTRL-↓), if the Confirm and Translate Next button    is grayed out 
and inactive (meaning that the translation is already in the Mini-TM).  

 

Translation 
saved in the 

Mini-TM 
 

Transfer 
button 

 

Update Mini-
TM button 

 Segment for which a 
match has been found 

Guideline to 
be consulted 

Space which may 
be used to write 

comments 
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23.  At times you may want to stop working sequentially and come back to previously translated 
segments to revise them. Use the Next Segment and Previous Segment buttons    (keyboard 
shortcuts CTRL-↓ and CTRL-↑) to navigate in the file. After making a revision, click on Update Mini-
TM   or press CTRL-U to save your latest version in the Mini-TM (normally you will want to 
Overwrite your previous version). 

24. Avoid using the button Approve And Go To Next Translated Segment   (This makes it 
difficult to re-edit a segment if needed later: you have to change the segment status in order to do so.)  

25. An XLIFF file contains formatting tags. These tags appear in red when the element is 
activated and normally must not be modified or deleted. At times you may however need to edit tags for 
inline formatting. More information is provided in the Appendix of this document. 

26. A last but important detail when translating XLIFF files in OLT: If for some reason (word 
order, length of sentence…) you do not need to use the space for a word or phrase in the source pane, then 
erase that word or phrase in the target pane but leave one blank space. 

 
Upload, preview, correct if needed, release 

27. Once you are (provisionally) satisfied with the translation of a unit, save it the last time 
(CTRL-S) and close it. Answer ‘Yes’ if asked “Do you wish to save the Mini-TM?” 

28. Login to the PISA 2015 Portal (if you are logged out), return to the Translation tab and 
upload the XLIFF file for the unit on which you have been working. Remember to upload from the 
“Translated” subfolder.  

29. You are then able to preview the unit with your translations implemented by clicking the 
Preview button. A new window (or a new tab) will open in the web browser, showing the translated unit.  

• Note: after uploading an edited XLIFF file to the PISA portal, the corresponding preview of the 
items sometimes may not reflect the latest changes you have made in the XLIFF file. If this is 
the case, please clear the cache in Firefox and try the preview again. 

• How to clear the cache in Firefox: 
 From the Tools menu, select Clear Recent History. If the menu bar is hidden, press Alt 

to make it visible. 
 From the Time range to clear, select the desired range. To clear your entire cache, 

select ‘Everything’. 
 Click the down arrow next to ‘Details’ to choose which elements of the history to 

clear. Click the ‘Clear Now’ button. 
30. In the preview window are buttons to show the English and French source versions of this 
unit. Clicking on these buttons will open a preview of the respective source version in a new window. 

31. If you find any errors or change your mind about any of your translation choices after 
previewing, re-open the XLIFF file in OLT, make your corrections, re-upload to the PISA portal (your 
latest upload overwrites any previous one), and re-preview the unit. 

32. Once you are fully satisfied with your translated unit, move on to the next unit and repeat the 
process with that XLIFF file. When you have completed all units within the cluster or batch, first upload 
your files to the portal. To do this, return to the Monitoring tab in the Portal, click the Execute button for 
the cluster. Then click the link labeled “Open new window with the files for this cluster”. Then, upload 
the new versions of the XLIFF files (as well as the TAS file  if it has been modified). To upload the new 
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versions, click the small up arrow icon ( ) to the right of the files. Once all files have been uploaded, 
return to the popup window in the monitoring report, click the I’m Done button, and move on to the next 
cluster (or stop the session). Attention: this step is irreversible. 

33. <Advise the National Centre of your progress according to the arrangements that have 
been agreed>.   

 
 

WORKFLOW PER TRANSLATION SESSION – QUICK REFERENCE GUIDE 

34. Log in to the PISA portal and go to the Monitoring tab. Select your country and language. 
Choose a unit to translate by clicking the Execute button. Save the XLIFF file(s) to an appropriate 
location on your computer. Download the relevant TAS. Launch previews as needed to assist you in the 
translation process. 

35. Launch OLT. Click on the Open File button  and navigate to the file you have 
downloaded. Do not let OLT automatically translate segments in the file. Save the file OFTEN as you 
work. 

36. Translate the segments one by one, by overwriting the text on the right side and then moving 
to the next segment by clicking on the Confirm and Translate Next button .  

37. Keep open the corresponding TAS, consult the item-specific translation/ adaptation 
guidelines and write comments for the attention of the Reconciler, if needed. 

38. Use the Translation Memory when appropriate/convenient: lift a previous translation by 
using the Transfer button . If edits are needed: make them, click on the Update Mini-TM 
button , move to the next segment by clicking on the Next Segment button . 

39. When all segments are translated, save the file (CTRL-S), close it, answer ‘Yes’ if asked to 
save the Mini-TM. 

40. Login to the PISA portal (if you are logged out), return to the Translation tab, upload the 
XLIFF by using the Browse button, and preview your translated unit by clicking the Preview button. If 
needed: re-open the XLIFF file in OLT, make your corrections, re-upload to the PISA portal, and re-
preview the unit. 

41. Once fully satisfied with all units in the cluster or batch, return to the Monitoring tab, click 
the Execute button for the cluster, upload the final versions of your files to the portal, click the I’m Done 
button, and move on to the next cluster.  
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APPENDIX – ADDITIONAL HINTS FOR USING OLT 

1. With the Search/Replace button   (keyboard shortcut F3) you can search for e.g. a 
specific term either in the source or in target version. This may be useful if you change a recurring term 
and want to make sure it is changed everywhere. 

2. With the Navigate/GoToSegment command (keyboard shortcut CTRL-G) you can go 
directly to a given segment if you know the segment number (found at the bottom of the OLT view). 

3. You can change keyboard shortcuts from the menu Options/ Customize Shortcuts. 

4. If you have accidentally marked a segment with status Approved (and thus can no longer edit 
it), right-click on the segment and select Mark Segment As Translated. 

5. Sometimes the first character typed in a segment will not appear the first time the keyboard 
key is pressed. If the key is pressed a second time the character will appear. 

6. Similarly, sometimes the first character in a segment will not be deleted the first time the 
backspace key is pressed. If the backspace key is pressed a second time the character will be deleted. 

7. You can use the Print options to print a file from the editor. You can choose from a selection 
of print options the format you would like the print-out to take. These print options can be accessed in the 
File menu by clicking on Print Options. The Print Options dialog appears. You can choose Without Tags 
to print only the text elements for the translation.  

 

8. XLIFF files contain formatting tags i.e. sequences of characters that indicate how text will 
be formatted on screen. In OLT these appear in red font colour when an element is activated and are 
write-protected (if the Tag Protection option is switched on, which is strongly recommended). 

 
9. Most of the time, you will not need to ‘tamper’ with formatting tags. For the above example, 
to translate the sentence with the correct formatting (the translation of “Explain” needs to appear in bold), 
you would overwrite “Explain” with the corresponding word or words in your target language, and 
similarly overwrite “your choice.” with the corresponding word or words in your target language. 

10. Occasionally (because of different word order or other circumstances), you will need to insert 
or delete formatting tags. To edit a tag in a target segment: 

• Click on Options in the menu and deselect Tag Protection. This will switch off tag protection. 
• Enter your translation with the correct formatting tags (see list below). 
• Click on Options in the menu and select Tag Protection. This will switch tag protection back on. 
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List of commonly used formatting tags 

Formatting tag(s) Effect 

<b>     </b> Text between tags will display in bold 

<i>      </i> Text between tags will display in italics 

<u>     </u> Text between tags will display underlined 

<sup>  </sup> Text between tags will display in superscript  

<sub>  </sub> Text between tags will display in subscript  

&nbsp; Sequence of characters will display as a non-
breaking space 

&ndash; Sequence of characters will display as a dash 

&mdash; Sequence of characters will display as an ‘emdash’ 
(long dash) 

<br /> Sequence of characters will cause a line break  
 

11. For example, to translate “Why” in French with the correct typographic conventions, a 
French translator would enter «&nbsp;Pourquoi&nbsp;?&nbsp;» – which will display as « Pourquoi ? ».  

12. It is important to check when previewing that no spaces have been deleted or added between 
words by accident. Remember also that if you do not need to use the space for a word or phrase that is 
available for English/French, then erase the English/French word or phrase in the target segment but leave 
one blank space. 

13. If you delete or edit formatting tags by accident, this will cause an error when importing the 
file into the software that generates the preview. If this occurs, you need to manually change the tag back 
to its original state. The original state can always be viewed in the corresponding source element. 

• Click on Options in the menu and deselect Tag Protection. This will switch off tag protection. 
• Manually change the tag back to its state as seen in the source segment. 
• Click on Options in the menu and select Tag Protection. This will switch tag protection back on. 
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